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1 Introduction
Congratulations
You have chosen a device manufactured by Pepperl+Fuchs. Pepperl+Fuchs 
develops, produces and distributes electronic sensors and interface modules for 
the market of automation technology on a worldwide scale.
Symbols used
The following symbols are used in this manual:

Handling instructions
You will find handling instructions beside this symbol
Contact
If you have any questions about the device, its functions, or accessories, please 
contact us at:
Pepperl+Fuchs GmbH
Lilienthalstraße 200
68307 Mannheim
Telephone: +49 621 776-4411
Fax: +49 621 776-274411
E-Mail: fa-info@pepperl-fuchs.com

Note!
This symbol draws your attention to important information.
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OIT***-F113-B12-CB*
Declaration of conformity

2 Declaration of conformity
This product was developed and manufactured under observance of the 
applicable European standards and guidelines.

The product manufacturer, Pepperl+Fuchs GmbH, D-68307 Mannheim, has a 
certified quality assurance system that conforms to ISO 9001.

Note!
A Declaration of Conformity can be requested from the manufacturer.

ISO9001
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3 Safety
3.1 Symbols relevant to safety

3.2 Intended use
The OIT system is an identification system designed exclusively for identifying 
codes that are stamped as a matrix of holes in metal plates. With the use of robust 
metal plates, the code carriers can be used in rough ambient conditions, such as 
those found in production and painting lines, with temperatures to 500°C (932°F).

3.3 General safety instructions
Always operate the device as described in these instructions to ensure that the 
device and connected systems function correctly. The protection of operating 
personnel and plant is only guaranteed if the device is operated in accordance 
with its intended use.
The operating company bears responsibility for observing locally applicable 
safety regulations.
Installation and commissioning of all devices must be performed by a trained 
professional only.
User modification and or repair are dangerous and will void the warranty and 
exclude the manufacturer from any liability. If serious faults occur, stop using the 
device. Secure the device against inadvertent operation. In the event of repairs, 
return the device to your local Pepperl+Fuchs representative or sales office. 

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt devices and any connected facilities or systems, 
or result in their complete failure.
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4 Product Description
4.1 Optical Identification Terminal - Use and application areas

The Optical Identification Terminal, or OIT system for short, is an optical 
identification system that employs methods of industrial image processing and is 
used in automated manufacturing processes, especially in harsh ambient 
conditions, where the use of code carriers with electronic components is made 
difficult or even impossible by cyclic temperature changes, for example. For the 
high temperature OIT identification system, read only tags of solid metal plates 
with a perforated matrix are applied, which are designed for use in temperatures 
up to 500°C and suitable for high mechanical stress. Simple installation and 
commissioning without complicated, time-consuming TEACH-IN processes 
enable rapid entry. Pluggable connections for the rapid exchange of devices and 
a controller with simple command set via the Ethernet interface guarantee simple 
operation. A scratch-resistant, replaceable quartz glass panel and sturdy metal 
housing make the OIT a robust, efficient identification system.

Figure 4.1 OIT systems
The OIT system is integrated in a single compact component: The camera, 
illumination unit and a DSP board for digitalizing and processing captured image 
information are enclosed in one housing.
Metal plates with a unique perforated matrix are attached for the identification of 
individual objects. The perforated matrix stamped into the metal plates contains a 
code carrier ID, which is detected by the identification system, processed digitally 
and transmitted to a computer via a network interface.
Data such as the type designation, lacquer color, etc. can be determined for each 
identified object using the code carrier ID. The OIT system is mounted directly in 
the system so that the code carriers are detected successfully.
8
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4.2 Model series
4.2.1 OIT200-F113-B12-CB

The OIT200-F113-B12-CB is designed for a read distance between 140 mm to 
200 mm to the read only codes (measured from the lower edge of the OIT 
system). The OIT system is equipped for this task with a wide-angle lens camera 
as well as a built-in infrared LED board for correct illumination of the metal plates.

4.2.2 OIT300-F113-B12-CB2
The OIT300-F113-B12-CB2 is designed for a read distance between 100 mm and 
270 mm to the read only codes (measured from the front lens on the OIT system). 
The OIT system is equipped for this task with a standard-lens camera as well as a 
built-in infrared LED board for correct illumination of the metal plates. The OIT300-
F113-B12-CB2 is specially designed to recognize small code sheets (OIC-......-
CB2).

4.2.3 OIT500-F113-B12-CB
The OIT500-F113-B12-CB is designed for a read distance between 200 mm and 
450 mm to the read only codes (measured from the front lens on the OIT system). 
The OIT system is equipped for this task with a standard-lens camera as well as a 
built-in infrared LED board for correct illumination of the metal plates.

4.2.4 OIT1500-F113-B12-CB
The OIT1500-F113-B12-CB is designed for a read distance between 750 mm and 
1700 mm to the read only codes (measured from the front lens on the OIT 
system). The OIT system is equipped for this task with a standard-lens camera as 
well as a external infrared LED lighting for correct illumination of the metal plates.
9
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4.3 Displays and controls
The illumination unit contains 7 LED indicators that give information on the status 
of the OIT system.

Figure 4.2 Illuminatiion unit of the OIT system
1 Code OK (Code OK)

Code read successful; flashes approximately 5 seconds for successful programming.
2 Error

Lights red when a read error occurs.
3 Trigger

 Lights yellow when a trigger sensor is connected.
4 Stability of image information

Lights red even if the image taken is recognizable. However, when ambient conditions 
worsen (camera image too bright/dark, too many structures in the image, object almost 
too far/too near, low contour, object just barely in image area), a read error can be ex-
pected.

5 Ready
Flashes while initializing approximately 30 seconds. During this time a Data Matrix code 
can be read in to (re)program the unit. No network connection to the OIT system can be 
established in the first 30 seconds. The LED lights up once the system is ready for oper-
ation.

6 Power
Lights green when power is supplied to the OIT system.

7 Infrared-illumination control
Lights up red when the infrared illumination is active

1

2

3

4

5

6

7

10
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4.4 Interfaces and Connections
The device includes the following connections:

Figure 4.3 Device connections on the OIT300, OIT500 and OIT 1500 systems

Figure 4.4 Device connection on the OIT200 system

Connection for the external illumination unit
There is a 4-pin M12 socket on the side of the OIT system housing (not on the 
OIT200 system) for connecting the external illumination. The following diagram 
shows the pin assignment:

Figure 4.5 External illumination pin assignments

1 Grounding screw
2 Power supply (Harting HAN Q 8/0 F plug)
3 Network (RJ45 network socket with push pull connector for IP65)
4 Trigger sensor (4-pin M12 socket)
5 External illumination (4 in M12 socket)

1 Grounding screw
2 Trigger sensor (4-pin M12 socket)
3 Network (RJ45 network socket with push pull connector for IP65)
4 Power supply (Harting HAN Q 8/0 F plug)

1 24 V illumination power supply
2 External laser control (LAS)
3 Ground (GND)
4 External illumination control (BEL)

1 2 3 4 5

1 2 3 4

1

3

24
11
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Connection for a trigger sensor
A 4-pin, M12 socket is located on the side of the housing of the OIT system for 
connecting a trigger sensor. The pin assignments are shown in the following 
illustration:

Figure 4.6 Trigger sensor pin assignments

Network connection
On the side of the housing of the OIT system is a network jack for connecting an 
RJ45 network plug. The pin assignments are shown in the following illustration:

Figure 4.7 Network connection pin assignments

1 24 V trigger sensor power supply
2 Not assigned
3 Ground (GND)
4 Trigger signal (TRIG)

1 Transmit data (+)
2 Transmit data (-)
3 Receive data (+)
4 Not assigned
5 Not assigned
6 Receive data (-)
7 Not assigned
8 Not assigned

1

3

24

3 4

5

6

7

8

1
2
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Power supply
The side of the housing of the OIT system has an 8-pin Harting HAN Q 8/0 F 
connector for the power supply. The pin assignments are shown in the following 
illustration:

Figure 4.8 Power supply connection layout

Mode bit 0 and mode bit 1 are digital inputs.

Galvanic isolation
There is no galvanic isolation between the supply line and the signal line in the 
factory settings. Both switches are positioned to the right in the factory presets. To 
galvanically isolate, both switches must be positioned to the left. After that, Pin2 
and Pin5 must be powered by a different power supply than the OIT.

1 n.c. (reserved)
2 Ground for separate I/O supply (GND IO)
3 Mode bit 1 (MOD 1)
4 Mode bit 0 (MOD 0)
5 24 V supply for separate I/O (24V_IO)
6 24 V supply to device (24 V)
7 n.c. (reserved)
8 Device ground (GND)

1

23 8

54 6

7

Note!
Resetting the Parameterization Lock
You can reset the activated parameterization lock by applying a logical high to the 
pin 3 mode bit 1 (MOD 1) and a simultaneous logical low to the pin 4 mode bit 0 
(MOD 0). After applying this logic level to the inputs, the locking bit in the 
parameter byte can be reset to "0".
13
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4.5 "OITControl" software 
OITControl provides you with a user-friendly interface for convenient and easy 
operation of the OIT system. With the use of an XML configuration file, OITControl 
can be adapted to the particular requirements of your plant.
Tasks of OITControl include establishing connections to OIT systems, the 
programming of operating parameters and system maintenance, as well as the 
transfer and display of data and error diagnostics.
The software provides the following functions, among others:

■ Visualization of the read code carrier ID and display of the transmitted data 
and control bits

■ Operator terminal for troubleshooting incorrect reading operations
■ Parameterization and maintenance of the OIT system
■ Diagnosis of the OIT system

You can download the latest version of the OITControl software and view 
additional information at http://www.pepperl-fuchs.com.

4.6 Delivery package
■ OIT***-F113-B12-CB*
■ Mounting base – pre-assembled on the enclosure
■ CD ROM including manual and OITControl software (You can download the 

latest version of the OITControl software and view additional information at 
http://www.pepperl-fuchs.com.)

4.7 Accessories
Various accessories are available.

4.7.1 Power supply
Part Description
V8HAN-G Socket, screw terminal
V8HAN-G-10M-PUR-
ABG

Socket, screened PUR cable, 10 m
14
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4.7.2 Connecting cables for trigger sensor and external illumination
Use the following cables to connect a trigger sensor and external illumination unit 
to the OIT system.
M12 connecting cables

Field-attachable M12 connectors

Other/alternative lengths available on request.

Material Length

M12 plug, straight M12 plug, angled

M12 socket, 
straight, 4-pin

PUR 2 m V1-G-2M-PUR-V1-G V1-G-2M-PUR-V1-W
5 m V1-G-5M-PUR-V1-G V1-G-5M-PUR-V1-W
10 m V1-G-10M-PUR-V1-G V1-G-10M-PUR-V1-W

M12 socket, 
straight, 4-pin

PVC 2 m V1-G-2M-PVC-V1-G V1-G-2M-PVC-V1-W
5 m V1-G-5M-PVC-V1-G V1-G-5M-PVC-V1-W
10 m V1-G-10M-PVC-V1-G V1-G-10M-PVC-V1-W

M12 socket, 
angled, 4-pin

PUR 2 m V1-W-2M-PUR-V1-G On request
5 m V1-W-5M-PUR-V1-G On request
10 m V1-W-10M-PUR-V1-G On request

Order number Description mm2 Cable 
V1-G Straight M12 socket, 4-pin max. 0.75 4 to 6 mm
V1-G PG9 Straight M12 socket, 4-pin max. 0.75 6 to 8 mm
V1-W Angled M12 socket, 4-pin max. 0.75 4 to 6 mm
V1-WV2A Angled M12 stainless steel 

socket, 4-pin
max. 0.75 4 to 6 mm

V1S-G Straight M12 plug, 4-pin max. 0.75 4 to 6 mm
V1S-W Angled M12 plug, 4-pin max. 0.75 4 to 6 mm
V1-G-Q2 Straight M12 socket, 4-pin 0.34 to 0.75 7 to 7.5 mm
V1S-G-Q2 Straight M12 plug, 4-pin 0.34 to 0.75 7 to 7.5 mm
V1-G-Q3 Straight M12 socket, 4-pin 0.14 to 0.34 4 to 6 mm
V1S-G-Q3 Straight M12 plug, 4-pin 0.14 to 0.34 4 to 6 mm
15
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4.7.3 Network cable

The OIT system is connected to the network by an RJ45 network jack.

Note!
Protecting the network connection to IP65
Using a commercially available RJ45 network plug to connect to the network 
socket of the OIT system does not ensure IP65 protection and the regular removal 
of the network plug may not be possible.  In order to ensure IP65 protection, use a 
HARTING RJ Industrial IP67 Push Pull Connector. Do not use the connector 
style "Variant 14".

Model Description
V45-G RJ45 network jack, without cable
V45-GP RJ45 network jack with push pull connector (IP65), without 

cable
V45-GP-10M-PUR-
ABG-V45-G

Connecting cable 10 m, RJ45 network jack with push pull 
connector (IP65)/RJ45 network jack
16
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4.7.4 Code Sheets
Various code sheets are available. You can see which read-only tag is suitable for 
which OIT type by looking at the ending of the model number (-CB1 or -CB2).

Code sheets can be ordered with the numbers of your choice. A minimum order of 
> 100 units is required. When reordering individual numbers, you cannot select 
the numbers. However, we guarantee that no numbers that already exist will be 
delivered.

Designation Description
OIC-C10ST-
CB1

Read-only tag for optical high-temperature 
identification system, steel. Value range: 6-
digit number between 000,000 and 999,999, 
plus one check digit. This steel code sheet is 
suitable only for applications in which the 
surface of the code sheet is protected against 
corrosion by means of a coating (e.g., paint). 
Rust will have a considerable impact on the 
quality of the reading.

OIC-C10V2A-
CB1

Read-only tag for optical high-temperature 
identification system, stainless steel. Value 
range: 6-digit number between 000,000 and 
999,999, plus one check digit. 

OIC-C11V4A-
CB2

Small read-only tag for optical high-
temperature identification system, stainless 
steel. Value range: 4-digit number between 1 
and 4095, plus a 6 bit check digit. 

Note!
Soiling of the Code Sheet
Please ensure that the code sheet is kept free of excess dirt. The code sheet can 
be cleaned using aggressive or abrasive cleaning agents.
Ensure that no other markings are made on the code sheets. Such markings may 
significantly impair code recognition. 
17
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5 Installation
5.1 Preparation

Unpacking the unit
1. Check that all package contents are present and undamaged.

 If anything is damaged, inform the shipper and contact the supplier.
2. Check that all items are present and correct based on your order and the 

shipping documents.
 If you have any questions, please contact Pepperl+Fuchs.

3. Keep the original packing material in case you need to store or ship the unit at 
a later time.

5.2 Mounting the Device
The device has a preassembled mounting base with four M6 threads positioned 
symmetrically on the base of the housing to allow easy installation of the OIT 
system in your plant.
The following illustration shows all the relevant housing dimensions in mm:

Figure 5.1 Dimensions of the OIT300 and OIT500 system

4xM6
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5715
6
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25610 68 20
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Figure 5.2 Dimensions of the OIT200 system

Figure 5.3 Dimensions of the OIT1500 system
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The following illustration shows the mounting distance of the code sheets in mm:

Figure 5.4 Mounting code sheets

5.3 Connecting the unit
Connecting the supply voltage
To connect the OIT system to a voltage supply source, proceed as follows:
1. Plug the Harting HAN Q 8/0 F-connector into its corresponding plug on the 

side of the housing.
2. Pull the protective sleeve over the connector until it locks in place.

 This protects the supply cable from being inadevertently pulled out.

60 m
m

140 m
m

65 mm

100 - 270 m
m

170 m
m

270 - 440 m
m

200 - 450 m
m

170 m
m

370 - 620 m
m

1000 - 1500 m
m

170 m
m

1170 - 1670 m
m

140 m
m

 - 200 m
m

OIT500

OIT300

OIT200

OIT1500

Note!
Mounting Code Sheets on the OIT300, OIT500, and OIT1500
Ensure that the code sheet is mounted perpendicular to the camera lens in the 
OIT system housing. A maximum tilt angle of 10° applies; this angle must not be 
exceeded.
20
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Establishing a network connection
To establish a network connection, proceed as follows:
1. If you use a standard RJ45 network plug, plug the RJ45 network plug into the 

network jack on the side of the housing; be sure the plug clicks into place with-
in the jack. To remove the RJ45 network plug, you need a small flat-head 
screwdriver to press the plastic tab down while pulling the RJ45 network plug 
out.

2. If you use a network cable that is equipped with a Harting RJ Industrial IP67 
Push Pull connector, plug it into the network jack located on the side of the 
housing until the black case latches into the jack. The network connection is 
protected to protection class IP65.

3. The OIT system has a factory-set, default IP address (192.168.0.65). You 
have to configure your network to enable the system to communicate on the 
network. To do so, use the configuration data provided in the "Network 
configuration overview" table (see table "Network configuration overview OIT" 
on page 29). 

Connecting a trigger sensor
To connect a trigger sensor, proceed as follows:
Plug the 4-pin M12 plug into its corresponding jack on the side of the housing.

Note!
Documenting the network configuration
The OIT system uses the TCP/IP protocol to communicate with the PLC. To 
ensure error-free communication, always keep notes on all changes that you 
make to the network configuration.

Note!
Protecting the network connection to IP65
Using a commercially available RJ45 network plug to connect to the network 
socket of the OIT system does not ensure IP65 protection and the regular removal 
of the network plug may not be possible.  In order to ensure IP65 protection, use a 
HARTING RJ Industrial IP67 Push Pull Connector. Do not use the connector 
style "Variant 14".

Note!
Network cables
To connect the OIT system to a computer directly, use a crossover network cable. 
If you are using the OIT system on a network, connect it using a twisted-pair 
network cable.
21
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5.4 Storage and transport
For storage and transport purposes, package the unit using shockproof 
packaging material and protect it against moisture. The best method of protection 
is to package the unit using the original packaging. Furthermore, ensure that the 
ambient conditions are within allowable range.
22
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6 Commissioning
6.1 Alignment/Adjustment

Illumination angle
To optimally detect the matrix of holes, the code carriers must be illuminated by 
the LED board from a specific angle that achieves the greatest possible contrast 
between the holes and the metal plate. The angle of correct illumination must be 
set based on the reading distance. The illumination unit is attached to a rail in the 
housing of the OIT system and can be slid to the correct position based on a 
scale.
The OIT200 system is preset to a distance of 170 mm between the read-only tag 
and OIT system 
The OIT300 system is preset to a distance of 200 mm between the read-only tag 
and OIT system. 
The OIT500 system is preset to a distance of 380 mm between the read-only tag 
and OIT system. 
The OIT1500 system is preset to a distance of 1500 mm between the read-only 
tag and OIT system. 
If you will be using this distance, you can disregard the following settings see 
chapter 5.2.
Setting optimal illumination angle
In order to set the optimal illumination angle, proceed as follows:
1. Unscrew the OIT enclosure cover.
2. Loosen the 2 screws at the base of the illumination unit (see Position 1).

Figure 6.1 Setting the illumination angle
3. Slide the illumination unit to the same distance as the OIT to the read-only tag 

(see Position 2).  The number on the dial will correspond to the distance from 
the read-only tag in mm. Align the screw that is closest to the camera 
(the left screw in the picture above) so that it is in line with the dial. The 
further the illumination unit is from the camera system, the greater the read 
distance.

4. Once the correct distance has been set, tighten the screws at the base of the 
illumination unit.

5. Screw the OIT enclosure cover back down.

Note!
Mounting Code Sheets on the OIT300, OIT500, and OIT1500
Ensure that the code sheet is mounted perpendicular to the camera lens in the 
OIT system housing. A maximum tilt angle of 10° applies; this angle must not be 
exceeded.
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Setting image sharpness

 In order to optimize image sharpness, proceed as follows:
1. Unscrew the enclosure cover.
2. Loosen the first screw on the lens (see Position 1).
3. Position the focus ring on the lens by using the screw (see Position 2).
4. Check the image sharpness by means of the Live-image function in 

OITControl (see "Set up OIT system with live image" on page 41). The edges 
of the holes in a code sheet should be reproduced as sharply as possible. 

5. Screw 3 and ring 4 do not normally need to be moved. These adjust the 
aperture of the lens. This only needs to be done for very fast code sheet 
movements, even when changes to the camera-shutter time and camera gain 
in OITControl do not lead to the desired results. (Read-only tag too dark)

Figure 6.2 Focusing the image
6. Once the image sharpness has been correctly set, gently tighten the screws 

on the lens.
7. Screw the enclosure cover back down.
The following inages show a picture with high contrast between hole and metal 
plate at optimal lighting through the LED board, and correctly adjusted image 
sharpness as well as a too highly illuminated image and incorrect adjustment of 
the code sheet (the lighting comes back out of the holes).

Note!
The device is preset. Image sharpness should only be adjusted if the image in 
OITControl is not optimal.
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Adjusting the camera shutter time and camera gain
Select theConfiguration > Configure OIT system menu item from the main bar 
and open the tab Image/Testing.

1. Set the camera shutter time to 2000 and the camera gain to 1.
2. Pass the code carrier in front of the OIT system. The speed should be the 

same as it will be in normal operation.
3. Now check the captured image. The holes in the code sheet should appear 

sharp. If the holes are not precisely round, reduce the camera shutter time 
and repeat the procedure.

 If the holes in the code sheet appear sharp, then changes to the camera 
shutter time are complete.

4. Check the illumination of the code carrier. If the camera image is too dark, 
increase the camera gain.

 Also check the LED display on the illumination unit (Stability) or the LED 
indicator in the OITControl software (OIT warnings) (both have the same 
functions). If the LED lights up, then the gain is set too high.

The settings made can be applied to all other OIT systems in the same 
environment. The OIT system uses infrared illumination and is therefore not 
susceptible to interference from other types of illumination. Direct sunlight or very 
high temperatures (> 800 °C) only can cause disturbances to the code sheet. The 
settings can be used when there are slight deviations from the preset distance (± 
50 mm).
Default Values

Shutter time Gain
OIT200 300 1
OIT300 1000 100
OIT500 1000 100
OIT1500 2500 150

Table 6.1 Camera shutter time and camera gain default values
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6.2 Programming
The OIT system is provided with default parameters see chapter 11.2. The 
operating parameters from these default parameters are stored in a file on the 
flash memory of the OIT. The operating parameters may be configured with the 
help of OITControl.
The operating parameters of the OIT system can be imported using a Data Matrix 
code that contains the required parameters. Use the Data Matrix code in the 
appendix to reset the OIT system to its default settings: see chapter 11.2
Parameterizing the device with a Data Matrix code
Correctly configure the OIT system for your equipment as follows:
1. Supply power to the OIT system. 

 Once the OIT system has been powered, it loads the data from the most 
recently saved parameter file; or the default parameters. The LED "Ready" will 
then flash for approx. 30 seconds.

2. Hold a Data Matrix code containing the new encoded operating parameters at 
a defined distance in the field of the OIT system. Hold the Data Matrix code at 
a distance of about 300 ... 350 mm in front of the OIT system. 

 Once the OIT system detects the code, the data is adopted as the new 
operating parameters and is written into the parameter file. The "COK" LED 
flashes for approx. 5 seconds. The OIT system will then restart. The "RDY" 
LED will flash again for approx. 30 seconds. Make sure that there are no Data 
Matrix codes in the image field when restarting the OIT system. Only then can 
a connection to the OIT system be established.

Data Matrix code resistant to dirt
You can make the default Data Matrix code or any other code resistant to dirt by 
sealing the code in a non-reflective film.

Note!
Network connections between OITControl and OIT system
After connecting the power, no network connection to the OIT system can be 
established in the first 30 seconds. During this time, the OIT system can be 
programmed with a Data Matrix code.
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7 Communicating with the OIT system
The following sections point out the different ways to communicate with the OIT 
system. Of note is the Easy Mode option, since this version requires the least prior 
knowledge.

■ TCP/IP communication: This deals with a detailed communicating and 
logging of the communication between the OIT system and a PLC. 
Individual actions must be initiated separately see chapter 7.1.

■ TCP/IP communication as per RFC1006 standard: a protocol extension 
for the TCP protocol see chapter 7.2.

■ TCP/IP communication with Easy Mode: the simplest connection 
between a PLC and an OIT system. The connection is made through a 
simplified set of instructions see chapter 7.3.

■ TCP/IP communication over a web browser (Diagnosis): Here a 
connection to the internal OIT system web browser can be made on which 
different information about the OIT system is located see chapter 7.4.

■ TCP/IP communication over FTP (diagnosis):  a connection to the 
internal FTP server of the OIT system can be made on which the fault 
patterns are located see chapter 7.5.

7.1 TCP/IP communication:
The TCP/IP protocol enables communication between the PLC and OIT system. 
Refer to the network configuration overview to view the configuration data (see 
table "Network configuration overview OIT" on page 29). The individual telegrams 
that are exchanged in this bidirectional communication are arranged as follows:
Data telegram PLC -> OIT without RFC1006

Byt
e

1 ... n n + 1 n + 2 n + 3 n + 4

hex 0xmm 0xmm Control byte Control byte
Data ID number SAL SAH

0 ... 550 Byte 2 bytes 1 byte 1 byte
max. 554 bytes 

(Default: 228 bytes)
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The data telegram from PLC to OIT is divided into the following 3 blocks:

The length of the data block is variable. For error-free communication between the 
OIT system and PLC, a concrete size must be defined for the length of the data 
block (default: 228 bytes).

Data telegram OIT -> PLC

Block Description
Data 
(0 ... 550 bytes)

The data in this block is transmitted to OITControl for display. (Default: 224 bytes)

ID number 
(2 bytes)

This block can transmit an ID number that uniquely identifies the respective data 
telegrams.

Control byte SAL 
(1 byte)

the control byte SAL is not currently being used and can be filled in with zeros.

Control byte SAH 
(1 byte)

The following control bits are transmitted from the PLC to the OIT system in the 
control byte SAH:
■ 0 = Default state to OIT (prompts a reset of the OIT system)
■ 1 = Read to OIT (prompts a read operation)
■ 2 = Current data to OIT (Info to OIT system that matches a data set in the data sent 

to the OIT system. Afterwards the read cycle ends.)
■ 3 = No data to OIT (info to OIT system that does not match a data set in the data 

sent to the OIT system. Afterwards the read cycle ends.)
■ 4 = Not assigned
■ 5 = Not assigned
■ 6 = Not assigned
■ 7 = Not assigned

Byte 0 1 2 3 4 ... 17 18 ... 23 24 ... 27
hex 0xmm 0xmm Control 

byte
Control 

byte
Fault

ID number (mirrored by 
PLC). If still no telegram 
from PLC, then: 0x0000

STL STH Manual 
entry:

■ 6 bytes 
ID

■ 8 bytes 
UID
If not 

manually 
entered, 
for every 
byte:"-"

Read ID 
number of 
the code 

carrier 
(6 bytes).
If ID/UID 
entered 

manually, 
for every 
byte: "x"

Fault 
messages 

see 
chapter 

7.3

2 bytes 1 byte 1 byte 14 bytes 6 bytes 4 bytes
28 bytes
28
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The data telegram from OIT to PLC has a fixed size of 28 bytes and is divided into 
the following 5 blocks:

Network configuration overview OIT

Network configuration overview PC

Block Description
ID number 
(2 bytes)

the ID number that is transmitted from the PLC is mirrored in this 
block.

Control byte STL 
(1 byte)

The following control bits are transferred from the OIT system to 
the PLC in the control byte STL:
■ 0 = Request default state (OIT requests a reset from the PLC 

(control bit 0 in byte n+4=initial state to OIT))
■ 1 = Not assigned
■ 2 = Read error
■ 3 = Not assigned
■ 4 = Waiting for data (read was successful, OIT system expects 

feedback from PLC)
■ 5 = Not assigned
■ 6 = Only TNR (additional parity bit that transfers the value "0" or 

"1")
■ 7 = Not assigned

Control byte STH 
(1 byte)

The individual control bits that are transmitted from the PLC in the 
control byte SAH are mirrored in the control byte STH.

Manual entry 
ID/UID (14 bytes)

Manually captured data is transmitted in this block during a failed 
read.
ID: up to 6 bytes are available. 
UID: up to 8 bytes are available.
If the data was not entered manually, a "-" is transmitted for every 
byte.

read ID number 
(6 bytes)

The ID number read by the OIT system is transmitted in this block.
If the data was entered manually, as in the case of an error, an "x" 
is transmitted for every byte. 

Fault(4 bytes) Fault messages see chapter 7.3

Designation value
IP address OIT system 192.168.0.65
Port (communication TCP/IP standard) 10005 (alterable)
Port (communication as per RFC1006/IP 
standard)

102 (fixed)

Port (OITControl) 10050 (alterable)
Port (web browser) 80 (fixed)
Port (TCP/IP, EasyMode) 10100 (fixed)
Port (Replay server) 2006 (alterable)

Designation Value
IP address 192.168.0.x (x = any number except 65 and 0)
Subnet mask 255.255.255.0
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7.1.1 For example: Successful read of a read-only tag
Below the communication between PLC and OIT system is more clearly illustrated 
through a successful read cycle:

1.  The PLC sends the command to the OIT system to read out the read-only 
tag ("Read to OIT" (SAH 1)).

2. Depending on the settings, the OIT system either immediately captures an 
image or the OIT system waits for a trigger signal and only then captures the 
image.
After the successful image capture, the OIT system decodes the data stored 
on the read-only tag and sends it to the PLC. At the same time, the OIT sys-
tem sends the message, "Wait for data" (STL 4) to the PLC.

3. At the end of the read operation, the PLC prompts resetting of the the OIT 
system to the ‘zero setting’ with the command "Starting position to OIT" 
(SAH 0)".
If a visualization of the process interface is to take place over OITControl, 
then the following item may also be taken instead of item 3:
The PLC determines which data set matches the input data and sends it to 
the OIT system together with the message "Current data to OIT" (SAH 2). If 
the PLC does not find a matching data set for the data input from the OIT 
system, the PLC will send the message "No data to OIT" to the OIT system 
(SAH 3).

This will end the complete read cycle.
7.1.2 Example: Read error in a read-only tag read

The communication for a read error between the PLC and the OIT system is 
illustrated below:

1.  The PLC sends the OIT system the command to read out a read-only tag 
("Read to OIT" (SAH 1).

2. Depending on the settings, the OIT system either immediately captures an 
image or the OIT system waits for a trigger signal and only then captures the 
image.
Once the image is captured, the OIT system determines a read error (the 
LED Error lights up on the illumination unit of the device; i.e. the left display 
area in OITControl in OIT LED status), and transfers the message "read er-
ror" (STL 2) to the PLC.
The read cycle is interrupted. Once the source of the error has been re-
moved, the read may be repeated. Otherwise, the data may be manually en-
tered.

3. Once the read operation has been repeated or the data has been manually 
entered, the OIT system will send the data to the PLC. At the same time, the 
OIT system sends the message, "Wait for data" (STL 4), to the PLC.

4. At the end of the read operation, the PLC prompts a reset of the the OIT sys-
tem to the ‘zero setting’ with the command “Starting position to OIT" 
(SAH 0)".
If a visualization of the process interface is to take place through OITControl, 
then the following may happen instead of item 3:
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The PLC determines which data set matches the input data and sends it to 
the OIT system together with the message "Current data to OIT" (SAH 2). If 
the PLC does not find a matching data set for the data input from the OIT 
system, the PLC will send the message "No data to OIT" to the OIT system 
(SAH 3).

This will end the complete read cycle.
7.2 TCP/IP communication (as per RFC1006 standard)

RFC 1006 (ISO Transport service through TCP) is a protocol extension of the TCP 
protocol. In addition to the TCP data, further information is transmitted between 
the participants in order to provide certain services to the operator. Data transfer 
normally takes place data-oriented over the TCP protocol. Neither information on 
the length nor information on the beginning or end of a communication is 
transmitted. This cannot be used in automation technology. Here, specific data 
packets that indicate length, beginning, and end must be used. Data transfer 
takes place message-oriented with RFC1006. Thus, only closed message blocks 
are sent through a connection and are recognized as such by the receiver. RFC 
1006 now specifies which information must be added to the transmitted data in 
the form of a header in order to ensure this. So RFC 1006 makes message-
oriented transmission available to applications set up on the data–stream oriented 
TCP protocol.
The TCP/IP protocol enables communication between the PLC and OIT system. 
For communication as per the RFC1006 standard, a block of 7 bytes, structured 
as follows, gives access to the data telegram.

The telegram blocks that attach to the RFC1006 block are created without 
RFC1006, in accordance with the telegram definition, (see chapter 7.1), so that 
the following sizes for data telegrams result as per the RFC1006 standard:

Byte 0 1 2 3 4 5 6
hex 0x03 0x00 0x00 0xEB 0x02 0xF0 0x80

RFC1006 header TSAP header
7 bytes

Data telegram orientation Data telegram length
SPS -> OIT max. 561 bytes
OIT -> SPS 35 bytes
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7.3 TCP/IP Communication with Easy Mode:
The TCP/IP protocol enables communication between the PLC and OIT system. 
For communication in Easy Mode, the host system connects to the OIT system via 
port address: 10100. The OIT system initially waits for a trigger signal when 
starting communication in Easy Mode. There are two different trigger signals:

Once one of the two trigger signals has been triggered, the OIT system captures 
an image. After the image has been successfully captured, the OIT system 
decodes the data stored on the read-only tag and sends this data to the PLC. If 
the read-only tag was not successfully read, the OIT system sends a "read error" 
to the PLC. The OIT system then waits for another trigger signal.

Figure 7.1 Easy Mode flow chart
Telegram structure:
The data telegram has a fixed length. The code read on the read-only tag is sent 
to the PLC in ASCII characters. If the code read on the read-only tag has less than 
six characters, leading zeros are added to the code. For example, the number 123 
is sent as 000123.
Successful Read of the Read-only Tag

Unsuccessful Read of the Read-only Tag

Trigger signal from an external trigger sensor (positive edge)
or
Trigger signal via the PLC telegram.

Trigger Send data

Byte 0 Bytes 1–6 Bytes 7–10 Byte 11 Byte 12 Byte 13
Start character Code number Status Checksum End character 

1
End character 
2

#(23 hex) 000001 to 
999999

See status 
table

Value x CR (0D hex) LF (0A hex)

Byte 0 Bytes 1–6 Bytes 7–10 Byte 11 Byte 12 Byte 13
Start character Code number Status Checksum End character 

1
End character 
2

#(23 hex) NOREAD 
(ASCII)

See status 
table

Value x CR (0D hex) LF (0A hex)
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Trigger Telegram (via Port 10100 for Software Triggering)

Status Table: Bytes 7–10

Byte 0 Byte 1 Byte 2 Byte 3
Start character Command: read code End character 1 End character 2
#(23 hex) R (52 hex) CR (0D hex) LF (0A hex)

Byte Group 
description

Subgroup description
7 8 9 10
bin bin bin hex
Bit 0 OITControl client connected
Bit 1 Parameterization lock active

Bit 0 Function 
could not be 
started or is 
not running

HTTP server not available
Bit 1 FTP server not available
Bit 2 NTP server not available
Bit 3 Logging program not running
Bit 4 Data Matrix decoder not active
Bit 5 Decoder not active

Bit 0 OIT 
warnings
(The read-
only tag 
could still be 
read)

Camera image too bright
Bit 1 Camera image too dark
Bit 2 Too many structures in image
Bit 3 The distance between the read-only tag and OIT system is too 

great
Bit 4 The distance between the read-only tag and OIT system is too 

small
Bit 5 Not enough contrast
Bit 6 The read-only tag is outside of the detection/capture range

0x01 OIT status
(The read-
only tag 
could no 
longer be 
read)

No punched holes found
0x02 Few punched holes found, first loop
0x03 Few punched holes found, second loop
0x04 No check marks found in range, check 1
0x05 Decryption not possible, check 1
0x06 No check marks found in range, check 2
0x07 Poor contrast
0x08 No check marks found in range, check 3
0x0A No check marks found in range, check 4
0x0B Decryption not possible, check 2
0x0F Checksum error
0x2A Timeout
0x31 Poor read-only tag (too many possible hole structures)
0x32 Timeout while determining the corner points
0x33 Timeout while decoding
0x99 Maximum repeat read reached

Double code-reading
0x9A Disconnect in process
0xFE No usable data from the PLC
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Calculating the Checksum
The individual bytes of the data telegram (byte 0 to byte 10) are calculated with 
the XOR function. The resulting value is then transmitted as a checksum. The 
receiver of this data telegram can also calculate a checksum using the data and 
compare this checksum with the checksum transmitted by the sender. If the two 
checksums are not identical, a transmission error has occurred.

7.4 TCP/IP communication over web browser
The OIT system contains a web browser that can be accessed over a normal 
interface. The web browser includes:

■ Last image: Displays last image processed .
■ Last error image: Displays last error image.
■ History: Displays history 
■ Results: statistical evaluation of reads and read errors in the last 

days/weeks/months and total. 
Permanently–set parameters:

■ OIT: OIT system information
■ Decoding (Image capturing / Inspection): Image capture and testing 

information.
■ Ethernet:Network connections.information
■ Communication: TSAP_Host and TSAP_OIT.information
■ Data telegram layout (SPS / OIT):OIT telegram and control telegram 

settings information
Launching the browser does not require a password. No data can be changed 
and transferred to the internal server over the web browser.

Definition x = unsigned byte
X = Byte 0 XOR Byte 1
X = X XOR Byte 2
X = X XOR Byte 3
...
X = X XOR Byte 9
X = X XOR Byte 10
Byte 11 = checksum value X
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7.5 TCP/IP communication through FTP
The OIT system includes an FTP server that can be accessed over a normal FTP 
connection. The following files are are stored in the device:

■ OIT_FW: text file that contains the series number of the firmware.
■ OIT_OS: text file that contains the series number of the operating system.
■ OIT_SN: text file that contains the series number of the device.
■ log_0: text file in which all log data is stored. As soon as the file becomes 

too large, another log file with a higher number is created.
■ errimg_0000000001:program file that stores the fault patterns. If there are 

more fault patterns, they are filed under an ascending number.
■ oitdat: files all set parameters as a binary file.

A password is necessary to establish an FTP connection to the OIT system. No 
data can be stored in the OIT system.
File format .pgm
The file format .pgm (portable gray map image) is an uncompressed gray-scale 
file. The color depth amounts to 8 bit and contains 256 gray scales (binary). The 
format is not compressed.
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8 OITControl
OITControl provides you with a user-friendly interface for convenient and easy 
OIT operation. With the use of an XML configuration file , OITControl can be 
adapted to the particular requirements of your plant.
Tasks of OITControl include establishing connections to OIT systems, the 
programming of operating parameters and system maintenance, as well as the 
transfer and display of data and error diagnostics.

8.1 Installing OITControl

The minimum hardware and software requirements are detailed below:
■ Processor: Pentium III 1 GHz
■ Working memory: at least 512 MB RAM
■ Hard disk space: at least 10 GB
■ Java Runtime Environment version 1.5 or later

The latest version of the software can be found on our homepage at 
www.pepperl-fuchs.com.
Installing OITControl
To install the OITControl software on the computer, proceed as follows:
Open the file "OITControl_setup.exe".

 Follow the instructions for the installation process.

Note!
Minimum hardware and software requirements
Before you begin installing the software, check that all minimum hardware and 
software requirements are met.
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8.2 Starting the program
Starting OITControl
Once installed successfully onto the computer (see chapter 8.1) launch the 
program as follows:
Double click the program's icon on the desktop.

 OITControl starts.
8.3 User interface

OITControl is designed to be similar to most Windows applications.
There is also an option – along with several unalterable standard functions – to 
adapt the OITControl user interface to your equipment by modifying the file 
OITControl.xml). The following refer to the software version in its initial state.

Figure 8.1 Start screen of OITControl

The header is displayed at the top of the screen. The right part of the header 
contains the familiar icons to minimize, maximize, and close the program. The left 
side of the header shows OITControl information for the software version next to 
the program name.
The menu bar with the menus File, Process, Display, Configuration and ? is 
displayed under the header.

Figure 8.2 OITControl menu
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The tool bar is displayed under the menu bar. All tool bar commands can also be 
activated from the menu bar. 

The current registered user name and the ID of the computer connected to the 
OIT system are displayed on the right side of the tool bar. If there is no connection 
to the OIT system, you will see the message: Offline mode / No OIT system 
connected.
Most of the start screen is taken up by the display area. The display area is 
divided into two areas: an overview on the left side and individual tabs on the right 
side provide all necessary information on the OIT system in a clearly structured 
way.

■ Left display area: with the OIT default configuration, the left display area 
provides a visualization of the communication between the PLC and the 
OIT system. The current PLC and OIT system control bits are transmitted 
from the OIT system to OITControl and arranged and displayed there as 
individual information blocks. The following information is displayed in the 
default configuration:

• Read cycle OIT, including the individual control bits: Request 
reset, read error, ID read

• Read cycle PLC, including the individual control bits: Reset, read 
start, current data, no data

• OIT LED status, including the status LEDs: Power, ready, check 
alignment, trigger, error, code OK

• OIT status information, including the status LEDs: Wait for 
trigger, SPS connection

Button Description
Connect to the OIT system (camera)
Alternatively: Select File > Connect to OIT or use the shortcut Ctrl+Q.

Disconnect from OIT system
Alternatively: Select File > Disconnect or use the shortcut Alt+Q.

Manual entry of ID/UID number(s)
Alternatively: Select Process > Manual entry
This function is only available if a failed read occurs.

Repeat read operation
Alternatively: Select Edit > Repeat read
This function is only available if a failed read occurs.

Display current camera image
Alternatively: Select Process > Camera image
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■ Right display area: with the OITControl default configuration, the right 
side display area provides detailed information on the connected OIT 
system. This information is arranged into tabs. The following tabs are 
available in the default configuration:

• OITControl messages: All OITControl actions are logged here 
and saved in a file on the computer hard drive.

•  OIT data set: In the default configuration, the numbers of the 
evaluated code carrier and the manually entered numbers are 
displayed here. If no OIT system is connected, the values in braces 
provide information on start position and the number of characters 
from the data set to be read. ID number: {262|6} means that the 
ID number in the data telegram begins at Position 262 and is 6 
characters long. The most recently generated image is also 
displayed.

• OIT debug display: The OIT system evaluates the captured 
images with regard to several factors. If the captured image is 
recognizable and a read error occurs due to a deterioration of the 
ambient conditions, then the tab OIT debug display OIT Debug 
display will provide further information as to possible causes.

Fault messages
- No holes or not enough holes found [1, 2, 3, 4]
- Code sheet cannot be decoded [5]
- Insufficient contrast on code sheet [7]
- Corner holes on code sheet not found [6, 8, 10, 11]
- Invalid check sum [15]
- Sheet quality insufficient [49]
- Timeouts [42*, 50, 51]
- Intern software error [negative value]

The status bar is displayed at the bottom of the screen. The left side of the status 
bar shows the last action executed along with date and time. The connected OIT 
system appears on the right side of the status bar.

Figure 8.3  OITControl status bar
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8.4 Basic program operation
Establish connection to OIT systems
In order to establish a connection to an OIT system, proceed as follows:

1. Click  or select Connect > file to OIT.

 The dialog window Choose OIT system... will open:

Figure 8.4 Select OIT system... dialog box.

2. Select the desired OIT system from the drop-down list or maually enter the IP 
address of the OIT system. More OIT systems may be added to the drop-
down list (by changing the file OITCamera.XML see chapter 11.1). If a new 
connection to an OIT system is established, at the next program start, the 
most recently used connection will be offered by default in the drop-down list 
(last used/last used).

3. Click OK.
 OITControl checks whether the desired OIT system is available, 

establishes the connection, and waits for confirmation from the OIT system. 
Each successful step in the connection is confirmed with a green checkmark 
in the dialog window. If an error occurs, a red cross will appear in the dialog 
window. After the connection has been established, the button Disconnect is 
activated. 
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Possible errors in establishing connections

Set up OIT system with live image
With the help of the Live-image function in OITControl, the administrator or 
primary user has the option of checking the alignment of the OIT system, the 
display window and its sharpness, image brightness and contour and, if 
appropriate, adapting them to the needs of their equipment. Proceed as follows:

1. Click  or select Process > camera image.

 The dialog window camera image will open.

Figure 8.5 Camera image dialog box

Error Remedy
"The connection 
request was denied by 
the OIT system. The 
following OITControls 
are already connected 
to the OIT system:"

A connection between OITControl and an OIT system is 
called a socket connection. No more than 2 socket 
connections are possible at any one time. If attempting a third 
socket connection, the following error message is generated: 
"The connection request was denied by the OIT system. 
The following OITControls are already connected to the 
OIT system:”. The connected OITControl socket connections 
will be displayed.
Close one of the existing socket connections and make a new 
attempt to connect to the desired OIT system.

IP address incorrect Enter a valid IP address or select a connection from the drop-
down menu (see "Establish connection to OIT systems" on 
page 40).

OIT system not enabled Supply power to the OIT system (see "Connecting the supply 
voltage" on page 20).

OIT system not 
accessible over network

Test the OIT system accessibility with the ping command.
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2. Select Live imagefrom the drop-down list.
3. Click OK.

 The dialog window Live image will open. The current live image will be 
displayed in the left part of the dialog window. The OIT system date and the 
OIT system time will be displayed in the right side. Previous selections can 
also be seen here whether in full or partial image.

Figure 8.6 Live image dialog box

4.  Since the Live-image function burdens the network with a higher volume of 
data transfer, a maximum of 10,000 live images can be taken in the default 
setting. The display of live images then stops and the dialog window is 
closed. If needed, start the Live image set-up over. The number of live images 
can be changed in the menu at Configuration > Configure OIT system  .

 Align the OIT system and adapt, if needed, the settings (field of view, 
sharpness, brightness, image contour, etc.) to the requirements of your 
equipment and check the settings by means of the live images in OITControl.

5. Once the OIT system has been optimally aligned and set up, close the dialog 
window Live image by clicking on Cancel.

OIT system start-up
Before putting the OIT system into operation and integrating it into your PLC, the 
interaction between the OITControl and the OIT system should be checked. For 
this, the administrator or primary user will be able to test the OIT system 
independent of the PLC. Proceed as follows:
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Select Configuration > Start-up.

 The dialog window Start-up OIT system will open. The current image will be 
displayed in the left part of the dialog window. In the right side of the dialog 
window in the area Read mode, the read mode can be switched to either direct 
read or trigger read. If the trigger-read mode has been selected but the trigger is 
missing, then the button Normal position will take you back to the start screen. A 
complete read process can be run in the area Automatic. Here the number of 
seconds after which a new read process is started can be set. Make sure that no 
previously read or incorrectly read reads are sent to the PLC.

Figure 8.7 Dialog box Commissioning OIT system...

Correct read errors: Repeat read operation
An instance may occur when the OIT system cannot read the data from a read-
only tag in a read operation through the PLC. In this case, the buttons Manual 
entry of ID/UID number(s) and Repeat read operationwill flash in the tool bar. 
Proceed as follows in order to correct the read error by repeating a read operation:
1. Check possible causes of the error: Is the read-only tag correctly positioned in 

the field of view of the camera (too close/too far to the lens/too tight in the field 
of view of the camera)? Remove any obstacles that could interfere with proper 
image taking. Check whether the lighting of the read-only tags is correct (too 
bright/too dark) and provide sufficient contrast.

2. Click  or select Process > Repeat read operation.

 The read operation is repeated.
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Correct read errors: Manual entry
A instance may occur when the OIT system cannot read the data from a read-only 
tag. In this case, the buttons Manual entry of ID/UID number(s) and Repeat 
read operationwill flash in the tool bar. Proceed as follows in order to correct the 
read error by manually entering the data:

1. Click  or select Process > Manual entry.

 The dialog window Manual data entry will open:

Figure 8.8 OITControl Manual data input

2. Enter the ID number of the read-only tag into the box Entry box for ID 
number. Enter the check digit of the read-only code into the second box. 
Optionally, the UID number may also be entered. For example: a defective 
read-only tag is replaced by a new read-only tag that merges with the UID 
number to create a unique identification code.

3. Click OK.
 The entered data is checked and subsequently sent to the OIT system. 

The manually entered data is displayed in the  Manual UID Number  and 
Manual ID number on the tab OIT data set readout. "XXXXXX" is displayed 
for ID number.
44



OIT***-F113-B12-CB*
OITControl
19
91

65
 20

13
-0

6

Change users
OITControl provides many user administration options. To change users, proceed 
as follows:
1. Select Configuration > User management > Change users.

 The dialog window Choose user... will open:

Figure 8.9 Select user... dialog box

2. From the drop-down list, click on User name for the desired user.
3. Enter the appropriate password into the box Password.
4. Click OK.

 The user change can be seen on the right side of the tool bar.
Predefined user roles
OITControl comes with the following, predefined user roles:

User roles Password User permissions
Pepperl+Fuchs pf ■ View all information

■ Manual input for failed reads
■ Set the date and time on the OIT system 

Pepperl+Fuchs 
Primary User

pfhaupt ■ View all information
■ Manual input for failed reads
■ Set the date and time on the OIT system
■ Configure the OIT system excluding frame 

definitions
■ Configure OITControl

Pepperl+Fuchs 
Administrator

pfadmin ■ View all information
■ Manual input for failed reads
■ Set the date and time on the OIT system
■ Configure the OIT system including frame definitions
■ Configure OITControl
■ Create and delete users
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Disconnect from OIT system
In order to disconnect an OITControl from an OIT system, proceed as follows:

1. Click  or select File > Disconnect.

 The dialog window Disconnect from OIT system... will open:

Figure 8.10 Disconnect dialog box

2. Click OK.
 The connection to the OIT system is disconnected and the socket 

connection is closed.
8.5 Parameterizing the OIT system

The OIT system is parameterized using an existing Data Matrix code see chapter 
6.2.

Open the parameter file
It is possible to load previously stored parameters into OITControl and transfer 
them to the OIT system. Proceed as follows:
1. Select Configuration > configure OIT System.

 The window invalid parameters... will open saying that no valid 
parameter data is yet available:

Note!
User role
In order to program the OIT system; i.e. to change settings in OITControl, log on 
as an administrator or primary user in OITControl (Configuration > User 
management > Select user).
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Figure 8.11 Invalid parameter  dialog box

2. Close the window invalid parameters... by clicking on OK.
 A dialog window Parameterization of the OIT system will open:

Figure 8.12 Network tab

3. Click  the button open file in Parameter set.
 The dialog window Open will open.

4. Select the stored parameterization.
5. To confirm the selection click on Open.

 The dialog window Open will close. The settings from the parameter file 
are displayed in the dialog window Parameterization of the OIT system.

6. In order to send the settings to the OIT system, click the button Write 
parameters in the OIT system.

7. In order to close the parameterization of the OIT system dialog window, 
click on end.
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Transferring the current settings from the OIT system
It is possible to transfer the current parameter settings from the OIT system to 
OITControl. To do so, proceed as follows:
1. Choose Configuration > OIT system configuration.
2. If the Invalid parameter data... window opens, close it by clicking OK.

 The OIT system parameterization dialog box opens.
3. Click Require parameter data in the OIT system area.

 The current parameter settings are now transferred from the OIT system 
to OITControl.

Configuring network settings
In order to adapt the network settings to the requirements of your network, 
proceed as follows:
1. Select Configuration > Configure OIT System.
2. If the window Invalid parameters... pops up, close it by clicking on OK.

 A dialog window Parameterization of the OIT system will open:

Figure 8.13 Network tab
3. In the area Ethernet change the settings for IP address, Subnet Mask, and 

Gateway in the appropriate fields according to the requirements of your 
network.

4. If a clock server is going to be used, enter the IP address of the clock server 
into the area NTP1-Server. As a backup, another clock server can be entered 
into NTP2-Server.

5. Take all remaining values as the default values.
6. In order to send the settings to the OIT system, click the button Write 

parameters in the OIT system  area.
7. In order to close the Parameterization of the OIT system dialog window, 

click on END.
Note!
Acceptance only after restart
In order to accept the changes in the system, the OIT system must be restarted.
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Changing ISO-on-TCP settings
To change the ISO-on-TCP settings, proceed as follows:
1. Select Configuration > configure OIT System.
2. If the window invalid parameters... pops up, close it by clicking on OK.
3. Go to the tab RFC1006:

Figure 8.14 RFC1006 tab
4. Enter the appropriate PLC values into the box TSAP-Host.
5. Enter the appropriate OIT-system values into the box TSAP-OIT.
6. In order to send the settings to the OIT system, click the button Write 

parameters in the OIT system.
7. In order to close the parameterization of the OIT system dialog window, 

click on end.
Activate TNR
To activate the TNR bit in the STL block of the data telegram to the PLC, proceed 
as follows:
1. Select Configuration > Configure OIT System.
2. If the window Invalid parameters... pops up, close it by clicking on OK.
3. Go to the tab Image/Check:

Figure 8.15 Image/testing tab
4. Activate the box Set TNR bitin the area Testing
5. In order to send the settings to the OIT system, click the button Write 

parameters in the OIT system  area.
6. In order to close the Parameterization of the OIT system dialog window, 

click on end.
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Direct read/read with trigger signal activated
A read-only tag read takes place either through an appropriate command from the 
PLC or through a trigger signal from an attached sensor.
1. Select Configuration > configure OIT System.
2. If the window Invalid parameters... pops up, close it by clicking on OK.
3. Go to the tab image/check:

Figure 8.16 Image/testing tab
4. In order to trigger the read command by PLC, check the box PLC direct 

readin the image capture area. The OIT system will trigger a read operation 
immediately after receiving the command. In order to use the trigger sensor to 
read after an appropriate PLC command, deactivate SPS direct read. The 
OIT system will then trigger a read operation with a rising edge at the trigger 
entrance.

5. In order to send the settings to the OIT system, click the button Write 
parameters  in the OIT system.

6. In order to close the parameterization of the OIT system dialog box, click 
on end.

Saving a parameter file
It is possible to save the settings in the OIT system parameterization dialog box for 
future use. To create a parameter file, proceed as follows:
1. Choose Configuration > OIT system configuration.
2. If the Invalid parameter data... window opens, close it by clicking OK.

 The OIT system parameterization dialog box opens.
3. Change any settings as necessary.
4. Click Save file in the File system area.
5. The Save dialog box opens.
6. Choose the location where you want the parameter file saved.
7. Confirm by clicking Save.

 The Save dialog box closes.
8. To close the OIT system parameterization dialog box, click Exit.
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9 OITControl menu structure
The menu for the OITControl software looks like this:

Figure 9.1 OITControl menu

All setting options are available in the menu:
■ Under File,files can be uploaded from your PLC, connections can be made 

to the OIT system, and programs can be closed.
■ Under Process, commands can be sent to the OIT system.
■ Under Display, the interface language can be set.
■ Under Configuration,all configurable parameters can be set.
■ Under ?, help can be found.

9.1 OITControl file menu

Figure 9.2 Menu bar OITControlFile

■ Configuration:  loading XML files.
■ Connect to the OIT system:  establishing connections to the OIT system.
■ Disconnecting:  an available connection to the OIT system is 

disconnected.
■ Load image file:  an available image is loaded.
■ End:  the OITControl program is ended.
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9.1.1 OITControl file menu > Configuration

Figure 9.3 Menu bar OITControl File > Configuration

■ Open configuration: Using an XML configuration file, you can adapt the 
appearance of the OITControl to the requirements of your plant. These 
configuration files can be opened in this menu.

■ Launch OIT system: Various IP Configuration files can be created and 
opened in this menu. Different OIT systems with their different IP addresses 
can be stored in one configuration file. When cueing the function Connect 
to the OIT system all available IP addresses for selection will be 
displayed.

9.1.2 ITControl file menu > Connect to OIT system

Figure 9.4 Select OIT system... dialog box.

■ left input area: Either the IP address last used or the IP address of the OIT 
system can be manually entered using the drop-down list in the left input 
area. More OIT systems can be added to the drop-down list (by changing 
the file OITCamera.XML see chapter 11.1). If another connection to an OIT 
system is established, during the next program start-up, the most recently-
used connection will be offered by default in the drop-down list (last 
used/last used).

■ right input area: The port number may be entered in the right input area.
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9.1.3 OITControl file menu > Disconnect

Figure 9.5 Disconnect dialog box

The OIT system is disconnected and the socket connection closed by selecting 
the menu item Disconnect.

9.1.4 OITControl file menu > Load image file
A dialog window opens in which the image file to be opened can be selected.

9.1.5 OITControl file menu > Exit
The connection to the OIT system is disconnected, the socket connection is 
closed and the program ended.

9.2 Edit OITControl menu

Figure 9.6 Menu bar OITControl Edit

■ Manual entry If a read-only tag is not recognized, the code may be 
manually entered here.

■ Repeat read operation: If a read-only tag is not recognized, the tag can be 
read here.

■ Camera image: Displays camera image.
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9.2.1 Process OITControl menu > Manual entry

Figure 9.7 OITControl Manual data input

The Manual entry dialog box consists of three input boxes:
■ Left input box: the ID number of the read-only tag is manually entered 

here.
■ Center input box: the check digit of the read-only tag is manually entered 

here. 
■ Right input box: The UID code is entered here. For example: a defective 

read-only tag is replaced by a new read-only tag that merges with the UID 
number to create a unique identification code.

The input boxes can still be defined under Configuration > Configure 
OITControl > Manual entry. There an optional preliminary check of the entered 
number(s) can be set before they are sent to the OIT system. see chapter 9.4.3.3
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9.2.2 Edit OITControl menu > Repeat read operation

Figure 9.8 OITControl Repeat read procedure

The read operation of the connected OIT system can be repeated here. This 
initiates a complete read operation, including communication to the PLC host 
computer.

9.2.3 OITControl menu Process > Camera image

Figure 9.9 Camera image dialog box opended

With the help of the live image function in OITControl, the administrator or primary 
user has the option of checking the alignment of the OIT system, the display 
window and its sharpness, image brightness and contrast, and, if necessary, 
adapting them to the needs of their equipment. There is also the option in the 
drop-down menu to display fault patterns and an evaluation with or without the 
hole recognition markings. A partial image can be pre-defined in the menu Only 
display partial image under Configuration > Configure OITControl > Image 
display tab . You also have the option of saving the images in pgm format so that 
you can send these images to P+F in the event of a support query, for example.
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9.3 OITControl file menu 

Figure 9.10 Menu bar OITControl View
■ Customize language:  Selection of different interface languages.

9.3.1 Display OITControl menu > Adjust language

Figure 9.11 Adjust language...dialog box
Change the language to be used in the menu bar and the dialog windows here. 
The left and right display areas are customized to your particular needs through 
an XML file which also controls the language.

9.4 OITControl Configuration menu

Figure 9.12 Menu bar OITControl Configuration
■ User administration:  select, change, log out, and delete users.
■ Customize login:  customizing the login.
■ Configure ITControl:  all OITControl parameters can be set.
■ Configure OIT system:  all OIT system parameters can be set.
■ Start-up:  start-up support of an OIT system.
■ Reboot OIT system:  OIT system is restarted.
■ OIT system time:  set the OIT system time
■ System log  display OIT system communication.
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9.4.1 OITControl configuration menu > User administration

Figure 9.13 Menu bar OITControl Configuration > User administration

■ Select user:  select users with password access.
■ Change password:  Change current user password.
■ Log-off:  logs off the current user.
■ Adding users:  adding new users. This can only be done by an 

administrator or primary user.
■ Deleting users:  deleting a user with passsword access.

9.4.1.1 OITControl configuration menu > User administration > Select user

Figure 9.14 selecet user dialog box

The current user is logged off and another user is logged on. Select the new user 
to be logged on from the drop-down menu. Additional actions can only be carried 
out depending on the clearance level of the new user. 
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Predefined user roles
OITControl comes with the following, predefined user roles:

9.4.1.2 OITControl configuration menu > User administration > Change password

Figure 9.15 change password dialog box

Change the current user password here. A concise description is recommended.

User roles Password User permissions
Pepperl+Fuchs pf ■ View all information

■ Manual input for failed reads
■ Set the date and time on the OIT system 

Pepperl+Fuchs 
Primary User

pfhaupt ■ View all information
■ Manual input for failed reads
■ Set the date and time on the OIT system
■ Configure the OIT system excluding frame 

definitions
■ Configure OITControl

Pepperl+Fuchs 
Administrator

pfadmin ■ View all information
■ Manual input for failed reads
■ Set the date and time on the OIT system
■ Configure the OIT system including frame definitions
■ Configure OITControl
■ Create and delete users
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9.4.1.3 OITControl configuration menu > User administration > User log-off

Figure 9.16 logout user dialog box

The current user is logged off and another user is logged on. Further actions can 
only be carried out after logging on again.

9.4.1.4 OITControl configuration menu > User administration > Add user

Figure 9.17 add user dialog box

Add new users here. It will be necessary to enter a (new) user name and 
password. The clearance level of the new user can be selected directly from the 
drop-down menu Clearance level. A concise description is recommended.
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User levels
For the OITControl Software, the following user levels are defined:

9.4.1.5 OITControl configuration menu > User administration > Delete user

Figure 9.18 delete user dialog box

The current user account will be completely deleted. Further actions can only be 
carried out after logging on again (under a different user account). An 
administrator can delete other user accounts.

Level User rights
deactivated ■ none
guest ■ View all information
User ■ View all information

■ Manual entry for failed/incorrect reads
■ Set date and time in OIT system

Primary user ■ View all information
■ Manual entry for failed/incorrect reads
■ Set date and time in OIT system
■ Configure the OIT system with 

exception of the telegram definition
■ Configure OITControl

Administrator ■ View all information
■ Manual entry for failed/incorrect reads
■ Set date and time in OIT system
■ Configure the OIT system including 

the telegram definition
■ Configure OITControl
■ Create and delete users
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9.4.2 OITControl configuration menu > Customizing the log view

Figure 9.19 Select Logging category... dialog box

Specify here whether you wish to only receive the INFO notices or also the 
DEBUG notices in the tab OITControl notices on the main page of the 
OITControl software see chapter 9.4.8.

9.4.3 OITControl configuration menu > Configure OITControl 

Figure 9.20 OITControl konfigurieren... dialog box

■ Launch program: Display of all important components at the start of the 
program.

■ Directories: Information on the directory structure can be found here.
■ Manual entry Definition of the dialog window input mask Manual entry.
■ Image display: sets the size of the partial image and the number of live 

images.
■ Data Matrix: settings for the print-out of the Data-Matrix code.
■ Statistics: displays of statistical values.
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9.4.3.1 OITControl configuration menu > Configure OITControl > Program start tab

Figure 9.21 Starting program tab

■ Language: display currently selected language
■ Autom. user log-off: changes the time after which the administrator or 

primary user is logged off and only a standard user remains active.
■ Autom. disconnection: change the time after which OITControl 

disconnects from the OIT system.
■ Last connected OIT system: displays the IP adress and IP port of the last 

connected OIT system. A Ping test can be activated here.
■ Window: displays the program window position.
■ Configuration files: set the configuration files that automatically launch for 

the user interface and cameras when the software is started.
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9.4.3.2 OITControl configuration menu > Configure OITControl > Directories tab

Figure 9.22 Directoriestab

■ Parameter directories: Here you set up the folder for the program 
directories to be loaded and the parameter directories to be stored.

■ Image directories: Here you set up the folder for the image directories to 
be loaded and the image directories to be stored.

9.4.3.3 OITControl configuration menu > Configure OITControl > Manual entry tab

Figure 9.23 Manual data input tab

■ ID box: Definition of the ID box in the dialog window Manual entry.
■ Checksums box: Definition of the checksum box in the dialog window 

Manual entry. 
■ UID box: Definition of the UID box in the dialog window Manual entry.
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9.4.3.4 OITControl configuration menu > Configure OITControl > Display image 
tab

Figure 9.24 image view tab

■ Partial image: instead of displaying the entire CCD camera field of view, 
only an adjustable part of it may be shown.

■ Live image display: sets the maximum number of live images. The Live 
image dialog box closes after showing the number of live images.

9.4.3.5 OITControl configuration menu > Configure OITControl > Data Matrix tab

Figure 9.25 DataMatrix tab

The settings in the menu Configure OIT system  can be printed out in a Data 
Matrix code. The DOT size of the Data Matrix code and the print color can be 
selected here.
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9.4.3.6 OITControl configuration menu > Configure OITControl > Statistic tab

Figure 9.26 Statistics tab

The OITControl compiles connection statistics between OITControl and the OIT 
system. 

9.4.4 OITControl configuration menu > Configure OIT system

Figure 9.27 Parameterization of the OIT system dialog box

■ Network: network connections information.
■ RFC1006: sets the TSAP-HOST and TSAP-OIT identifiers.
■ OIT telegram: OIT telegram settings.
■ Control telegram: control telegram settings.
■ Image/Testing: settings for all code recognition.
■ Image: defines the area in which the code sheet should be read out.
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9.4.4.1 OITControl configuration menu > Configure OIT system > Network tab 

Figure 9.28 Network tab

■ Version information: Displays OIT system version.
■ Ethernet: Displays the current network IP address with subnet mask snd 

gateway. If a connection to a DHCP is to be established, it may be activated 
here.

■ Network ports Displays current network ports for PLC, visualization 
(OITControl), and replay server (another server to aid logging). The port 
addresses can be freely chosen.

■ NTP1 server: Displays the IP address of an NTP server. The Network 
Time Protocol (NTP) is a standard to synchronize clocks in computer 
systems through packet-based communication nets. As a rule, NTP uses 
the transport protocol UDP. It was specially developed to give reliable 
clock-time in networks with variable packet run-time. But the transport 
protocol TCP can also be used. Moreover, the right time zone can be set 
here.

■ NTP2 server: see NTP1 server description. Another Network Time 
Protocol Server can be added here. Adding another NPT server provides a 
backup in the event of the first server failing, but it is not essential.

Note!
Acceptance only after restart
In order to accept the changes in the system, the OIT system must be restarted.
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9.4.4.2 OITControl configuration menu > Configure OIT system > RFC1006 tab

Figure 9.29 RFC1006 tab

■ TSAP host: Displays communication access point on the host page in 
Ascii characters or Hex characters

■ TSAP-OIT: Displays of communication access point on the OIT system 
page in Ascii characters or Hex characters

9.4.4.3 OITControl configuration menu > Configure OIT system > OIT telegram tab

Figure 9.30 OIT telegram tab

■ Telegram: Adapting the OIT telegram to the present OIT system.
Note!
No changes to the default values
Make no changes to these values if possible. That would change the protocol and 
could prevent new connections to the systems from being established.
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9.4.4.4 OITControl configuration menu > Configure OIT system > Control telegram 
tab

Figure 9.31 Control telegram tab

■ Telegram: Adapts the control telegram to the present control.

Note!
Changes only with administrator rights
Changes can only be entered here when logged on as an administrator.

Note!
No changes to the default values
Make no changes to these values if possible. That would change the protocol and 
could prevent new connections to the systems from being established.

Note!
Changes only with administrator rights
Changes can only be entered here when logged on as an administrator.
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9.4.4.5 OITControl menu Configuration > Configure OIT system > Image/testing 
tab

Figure 9.32 Image/testing tab
■ Image capture: Input camera shutter time and camera gain. In order to 

trigger the read command through the PLC, check the box PLC direct 
read in the image capture area. The OIT system will then trigger a read 
operation immediately after receiving the command. In order to trigger a 
read through the trigger sensor after an appropriate PLC command, 
deselect the check box PLC direct read. The OIT system will then trigger a 
read operation with a rising edge at the trigger input after an appropriate 
PLC command.see "Connection for a trigger sensor" on page 12

■ Testing: You can specify whether the TNR bit should be transmitted to the 
control as "0" or "1" under Set TNR bit. The maximum number of identical 
codes that can be detected in succession can be set under Max. permitted 
identical code. If you set this to two, the system will read a code twice 
consecutively before generating an error message. If a 0 is entered then the 
function is disabled.

■ LED illumination: the external illumination is switched on here. To do this, 
an external illumination must be connected to the external 4 pin M12 
socket. See "Connection for the external illumination unit" on page 11

■ Data carrier: type and specification of code sheet position. All possible 
positions of the sheet are tested in the default state. Here an 11 must be set 
in order to read small code sheets. See chapter 4.7.4. Note: The codes are 
read in inverted because of the internal mirror in the OIT200.

■ Parameter bytes 0 to 3: Changes to parameters in the OIT system can be 
blocked with the parameter byte Lock programming . The change of time 
can be automated in countries on summertime/ daylight savings time with 
the parameter byte Summertime on .
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9.4.4.6 OITControl Configuration Menu Bar > Configure OIT System > Evaluation 
Image Tab

Figure 9.33 Evaluation image tab

■ Evaluation image: This tab allows a specific section in the image shown to 
be selected. Only this section is used by the camera for the code search. To 
select a section, draw a box around the area required for evaluation using 
the mouse.

Note!
Resetting the Parameterization Lock
You can reset the activated parameterization lock by applying a logical high to the 
pin 3 mode bit 1 (MOD 1) and a simultaneous logical low to the pin 4 mode bit 0 
(MOD 0). After applying this logic level to the inputs, the locking bit in the 
parameter byte can be reset to "0".
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9.4.5 OITControl configuration menu > Start-up

Figure 9.34 Dialog box Commissioning OIT system...

The current image will be displayed in the left part of the dialog window. The read 
ID number will appear on the right side of the dialog window in the ID area, and in 
the Read modearea, the read mode can be switched to either direct read or 
trigger read. If the trigger-read mode has been selected but the trigger does not 
appear, then the button Normal position will lead back to the initial situation. A 
complete read operation can be run in the Automaticarea. Here you can setthe 
number of seconds after which a new read operation wil  start. If no image is 
displayed, click on OK to start a read-in of an image. see "OIT system start-up" on 
page 42
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9.4.6 OITControl configuration menu > Reboot OIT system

Figure 9.35 OIT-System rebooten... dialog box

The OIT system can be restarted through this menu item (reboot). Upon 
confirmation, the open socket connection to the OIT system is closed through 
OITControl. The system must be rebooted after changes to the IP address or 
language.

9.4.7 OITControl configuration menu > OIT system time

Figure 9.36 Menu box OITControl Configuration > OIT system time

■ Read OIT system time: The currently set system time of the OIT system 
can be read out. Check the indicated data after successful data 
transmission (date and time). If the difference is too great, then the time 
between the OIT system time and computer time can be synchronized.

■ Update OIT system time: The currently set system time of the OIT system 
can be synchronized to the current computer time. This should only take 
place when the OIT system time difference and unavailable time server 
(NTP1 server / NTP2 server) is too great.

Note!
The OIT system time settings are lost when the system is restarted.
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9.4.8 OITControl configuration menu > System login

Figure 9.37 System-Logging dialog box
The OIT system log file is displayed in this dialog window.

9.5 OITControl help menu

Figure 9.38 Menu bar OITControl ?
■  Help:  starting Online help.
■ through...: Display all relevant program information.

9.5.1 OITControl ? menu > Help

Figure 9.39 Helpdialog box
Part of the documentation may be accessed as online help.
73



OIT***-F113-B12-CB*
OITControl menu structure
19
91

65
 20

13
-0

6

9.5.2 OITControl ? menu > over...

Figure 9.40 About... dialog box

Displays all relevant program information.
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10 Troubleshooting
10.1 What to do in the event of an error

Before requesting a service call, please check that the following actions have 
been taken:

■ Test the equipment according to the following checklists,
■ Telephone assistance from the Service Center in order to isolate the 

problem.
Checklist
1. Save the fault pattern with the ending .pgn. Both options are provided in the 

Save as dialog window. Also, save the image with hole recognition marking 
and without hole recognition marking to simplify subsequent error diagnosis.

2. Check the LED display Check alignment on the right side of the OITControl 
user interface. If the LED lights up, please check the illumination and 
alignment of the code carrier using the live image display.

3. Open the tab OIT debug display on the right side of the OITControl user 
interface. All important messages concerning the entire OIT system appear 
there.

4. Analyze the fault pattern. Look at the fault pattern with the hole recognition 
markings. This image shows what the OIT system sees and which code it 
does or does not recognize.

5. Check the OIT system standard values. See chapter 9.4.4
6. Contact the Service Center. Please have the fault patterns and version 

numbers of the OIT system at hand. The version number can be found under 
Configuration > Configure OIT system in the Network tab.
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11 Appendix
11.1 Structure of the OITCamera.XML file

All network addresses for all desired OIT systems can be stored in the 
OITCamera XML file. This makes it easier to select individual OIT systems, since 
a selection of OIT systems is already displayed when making a connection 
request to OITControl.

Structure of the XML file:
The subfolder Cameras is in OITCamera. Do not change this file name. Any 
number of OIT systems with their IP addresses can now be added to the subfolder 
Cameras.
Adding a new OIT system
1. Copy one of the two already-existing folders.
2. Write the IP address of the new OIT system in the copied folder.
3. Set the IP port to the value at which the OIT system was configured. (default: 

10050)
4. Any OIT system name can be entered under CameraName.
5. The location of the camera can be entered for CameraLocation.

 If several cameras are to be entered, repeat steps 1 - 5.  Otherwise, the 
file can be saved and loaded to OITControl.
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11.2 Default values of the OIT system
Ethernet
IP address 192.168.0.65
Subnet mask 255.255.255.0
Gateway 192.168.0.1
DHCP false
Network ports
PLC Port: 10005
Visualization Port: 10050
Replay server 2006
NPT1 server: IP address 84.16.227.207
NPT1 server: Protocol UDP
NPT1 server: Time zone 1
NPT2 server: IP address 71.40.128.148
NPT2 server: Protocol UDP
NPT2 server: Time zone 1
TSAP host / TSAP-OIT
Host SPS_NAME
OIT: OIT_NAME
OIT telegram
Message counter position / Size 0 / 2
Control byte STL position / Size 2 / 1
Control byte STH position / Size 3 / 1
TNR number manual position / size 4 / 6
FSNR number manual position / size 10 / 8
ID number position / size 18 / 6
Status fault message 24 / 4
Control telegram
Data set position / size 0 / 224
Message counter (SPS) position / size 224 / 2
Control byte SAL position / size 226 / 1
Control byte SAH position / size 227 / 1
Image capture
Camera shutter time 2000
Camera gain 150
PLC direct read false
Testing
Set TNR bit false
Max. permitted identical code 0
Illumination
external illumination false
Data carrier
Code sheet type 00
Parameter byte 0
Lock parameterization false
Summertime on false
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The following Data Matrix code may also be used to set the default values. See 
chapter 8.5 and See chapter 6.2
78



OIT***-F113-B12-CB*
Appendix
19
91

65
 20

13
-0

6

11.3 FTP connection using FileZilla software
When using "FileZilla" software, make sure you configure the following settings:

■ Use active mode
■ Only allow one connection

Figure 11.1 Adjustment FileZilla
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